
Mastering Internet Development: 
README File
Welcome to Mastering Internet Development. This file contains additional information about 
Mastering Internet Development not included in online Help. 

The World Wide Web is an evolving phenomena, with new ideas and technologies being created 
daily. The Mastering Series team has taken this into account and extensively tested this title with the 
latest tools and technologies. However, because of the dynamic nature of the Web, you may 
experience performance or configuration problems using this title, depending upon your hardware, 
software, or internet connectivity combinations. For instance, based on your Internet service provider 
or the type of proxy server you're running, you may not be able to take advantage of the Internet 
connectivity features of this course. The Mastering Series team will continue to test this product and 
post the latest information on our Product Web Site.

Please be sure to check out the Mastering Internet Development Product Web page. Choose 
the Product Web Site command from the Help menu to jump to it. This README information will be 
updated on the Product Web page.

This README file contains important and helpful information on the following topics:

Section Description
1 Send Us Your Feedback
2 Setup Issues
3 Operating System Issues
4 Removing Mastering Internet Development
5 Using the Title's Internet Features
6 Potential Problems Running this Title
7 Performance Issues
8 Hardware Problems
9 Printing Problems
10 Microsoft Tools included on the CD
11 Technical Support
12 Generic Multimedia Information

To read this file on-screen, use the PAGE DOWN and PAGE UP keys. You can also print the file 
by choosing the Print command from the File menu in virtually any Windows-based word 
processing program.

1 Send Us Your Feedback
We welcome your feedback. Let us know how Mastering Internet Development has helped you gain 
expertise in creating solutions. You can reach us via any of the following:

Internet: devtrain@microsoft.com

Mail: Mastering Series Products
Microsoft Corporation
One Microsoft Way
Redmond, WA 98052-6399

Fax: (206) 936-7329
Attn: Mastering Internet Development

Please note that we receive a number of suggestions and comments regarding Microsoft products 
and are unable to respond directly to each one. However, be assured that your recommendations, 
ideas, and remarks are recorded and will help shape future versions of our Mastering Series 
products.

2 Setup Issues
The Setup program's default settings will load the Mastering Internet Development title to your C: 



drive in the MID folder. You can assign application files to a different drive; however, Setup will copy 
as much as 8.5 MB of system files to your WINDOWS\SYSTEM subdirectory.

Because Mastering Internet Development installs system files that may be shared with other 
applications, you must shut down other applications, including Microsoft Office, before running Setup.
If you have closed all other open applications and you encounter problems during Setup, make sure 
your system meets the minimum requirements necessary to install Mastering Internet Development.

Setup will not complete properly if you remove the Mastering Internet Development CD-ROM during 
Setup, or attempt to start the application before Setup is complete. 

Internet Explorer 3.0 Beta 2
To help you get onto the World Wide Web quickly, Mastering Internet Development includes the Beta 
2 version of Internet Explorer 3.0. You should install the most recent version of Internet Explorer as 
soon as possible. Internet Explorer is available to download from the Internet Explorer page on the 
Microsoft Web site, http://www.microsoft.com/ie.

System Requirements
Mastering Internet Development will run on the following minimal system; however, performance will 
improve with more RAM or a faster CD-ROM drive.

· Personal computer with a 486DX or higher processor, running Windows 95 
· 8 MB of memory (16 MB or more recommended)
· 10 MB of available hard-disk space (40 MB to work with lab files on your hard drive)
· MPC2-compatible CD-ROM drive
· Super VGA or higher-resolution video adapter capable of displaying 256 colors or greater
· Microsoft Mouse or compatible pointing device
· MPC2-compatible audio board

3 Operating System Issues
Microsoft Windows NT 3.51 
Mastering Internet Development runs under Microsoft Windows 95. It will not run under Windows NT 
version 3.51. The reason for this is that Mastering Internet Development is dependent on Microsoft 
Internet Explorer version 3.0 beta or later, which does not run under Windows NT version 3.51.

Several lab exercises included in this title, however, require you to run Windows NT 3.51 or later, in order
to run Microsoft Internet Information Server. If you want to complete lab exercises that require Windows 
NT, and want to have Mastering Internet Development running simultaneously, we recommend the you 
have two PCs; one functioning as a client machine, the other functioning as a server: 

Client PC
· Windows 95
· Internet Explorer 3.0 beta or later
· Mastering Internet Development

Server PC
· Windows NT 3.51 or later
· Microsoft Internet Information Server 1.0 or later

Microsoft Windows NT 4.0 beta or later 
When we released Mastering Internet Development,  Microsoft Windows NT version 4.0 was in beta.  
Because the beta status of Windows NT 4.0 at the time Mastering Internet Development released, we do
not offer product support for users attempting to run Mastering Internet Development under Windows NT 
4.0.  

If you want to run Mastering Internet Development on a PC running Windows NT 4.0 beta or later, we 
recommend you do so on a test machine, that does not contain any work-critical data or applications.  



We will not offer product support to users running Mastering Internet Development under Windows NT 
4.0 beta or later.

4 Removing Mastering Internet 
Development
To remove Mastering Internet Development from your computer, run Setup again and choose 
Remove All. You can also uninstall Mastering Internet Development by running the Add/Remove 
Programs application in the Control Panel. 

You may also need to do the following:
· Delete the Mastering Internet Development shortcut. If you moved the shortcut to a different

folder after installing the application, Setup will not be able to detect the new shortcut location or
delete it. After running Setup (with Remove All), go to Windows Explorer and delete the 
shortcut(s). 

· Delete the MID directory. The MID directory (or the directory you specified as the destination 
directory during Setup) will not be removed because it may contain files that you modified. If 
you did a Complete installation, two subdirectories were added: "Lists" and "Labs." If you 
worked on any of the labs or added topics to the Notebook, that information is saved in those 
subdirectories. If you still want to remove these directories,  you can delete them by going to 
Windows Explorer, selecting the directory, and pressing DELETE.

Warning
When running Setup with the Uninstall option you may receive a dialog box with a warning about 
deleting a shared file. This dialog only occurs when Setup prepares to remove a file that another 
application may use. If you remove the file, be aware that other unregistered applications that use 
that same file may no longer run correctly.

5 Using the Title's Internet Features
Mastering Internet Development includes the following Internet features:

Launching URLs
This product contains Universal Resource Locators (URLs) that allow you to jump to information on 
the Internet. URL addresses change over time as Web sites and pages are added, deleted, modified,
and moved. To keep the Mastering Internet Development title current, a URL jump table has been 
implemented in the title. Whenever you click on an URL jump in the title, the table resolves this 
request to an Internet URL, then launches Internet Explorer to locate that resource.

Product Update
The Product Update feature allows you to modify the title's URL jump table. If a URL link fails, or you 
suspect it has changed, use the Product Update command from the File menu to update this table 
from the Internet. Please note that after you use this command, you may need to restart the 
Mastering Internet Development title to see any changes in the content. If you have questions about 
using the Product Update feature, consult the Help file.

Product Web Site
Use the Product Web Site command from the Help menu to jump to the Mastering Internet 
Development Web page. This page will contain any future errata information, and pointers to 
additional information.

6 Potential Problems Running this Title
This section describes problems you may experience when running Mastering Internet Development.

· Beta Software: Some of the material in this course is based on pre-released versions of 
Microsoft Internet tools and operating systems. There may be discrepancies between 



information referenced in the course and the released versions of these products. 

· Lab 4, Exercises 1 and 2: The Spin32 and MaskedEdit controls may not self-register properly 
when downloaded by Internet Explorer Beta. This will cause them to work incorrectly. If you 
have Microsoft Visual Basic or Microsoft Visual C++, installing these products on the Client 
computer will correctly register the controls.

· Chapter 5, "Setting and Returning Properties Sample" sample code: The Slider control 
may not self-register properly when downloaded by Internet Explorer Beta. This will cause it to 
work incorrectly. If you have Microsoft Visual Basic or Microsoft Visual C++, installing these 
products on the Client computer will correctly register the control.

· Lab 5, Optional Exercise: This exercise may not work correctly, due to problems with the 
HTML Select control in the Beta version of Internet Explorer.

· Lab 9, Lab Solution: This lab requires installation of Microsoft Exchange in order to install the 
OLE Messaging library. If you do not have Microsoft Exchange installed on your machine, you 
will receive the VB error "Can't find project or library" when trying to send e-mail using the lab 
solution application.

· User Profiles: If you change User Profiles in Windows 95 after installing this course, you 
should continue to log onto your machine with the same username you used when installing the
course. Different users who have altered the default User Profiles settings may experience a 
path error dialog when restarting the course. Using the original username will avoid this 
problem.

· Library Articles: Library articles included in this title are not edited by the Mastering Internet 
Development team. You may encounter documentation errors, references to page numbers or 
files, and formatting problems. Addresses, phone numbers, and other contact information 
appearing in this title may have changed since the time of publication. 

· Topic Titles: Some of the topic titles in the application will be cut off when running Mastering 
Internet Development in lower display resolutions. 

· Palette Flash:  Palette flashes can occur when switching between Mastering Internet 
Development and other running applications, and when starting or stopping animations and 
demos.

· Graphics: This title is designed to run on machines capable of displaying 256 colors or more. 
Though the title does run on systems displaying 16 colors, there is a noticeable drop in image 
quality. Some large graphics may display out of the window when running the title at 640 x 480 
resolution. It is recommended that you run this application in 800 x 600 mode or greater. The 
graphic viewer in this application allows you to toggle graphics between large and small views. 
By clicking on the viewer, you can change the size of the graphic. The viewer will remain the 
size that you last viewed a graphic. If an image appears distorted or compressed, click in the 
graphic viewer to make sure you are viewing the entire image. Note that some small graphics 
do not change size.

· Navigation and Topic areas:  If using keyboard keys to navigate through the Table of Contents
or the Topic area, you may need to manually change the focus of the application, depending on 
the content you want to affect. You can change the focus by clicking on the area you want to 
navigate. On some systems, the vertical scroll bar may change size when scrolling through 
topics and labs, or navigating through the Table of Contents.

· Printing: The media represented by icons in the text area (graphics, sample code, tips, and 
answers) will not print when printing the current screen. To print this information, choose Print 
when the media is displayed in the active window. If you experience problems printing over a 
network, consult your network administrator to make sure your printer settings are correct. 
Solutions for common printing problems are described in Section 8 of this README file, 
"Printing Problems." If you choose to print the Glossary, the entire Glossary will be printed.

· Text: Mastering Internet Development uses your system settings to display some foreground 



and background colors. You may want to choose a compatible display combination (such as the
Windows Standard color scheme) for best visual results. When displaying glossary popups 
within the text, the application will sometimes lose focus. To remedy this, click in the Topic area; 
focus will return to the application.

· Video: .AVI files will only run if you've installed the Multimedia options when setting up 
Windows 95. Setup will look for multimedia options on your system and notify you if they are not
installed. If this is the case, you will need to install the appropriate options. Even with 
appropriate hardware, you may experience long wait times while video files are being loaded, 
and you may encounter errors in audio/video synchronization during playback.

7 Performance Issues
There are several ways to make Mastering Internet Development run faster. Many of the methods 
described below are general tips that will improve the performance of any application under 
Windows. Consult your Windows manual for more details.

Mastering Internet Development uses your computer's random access memory (RAM) to display 
pictures and play video and audio. If Mastering Internet Development runs slowly or if you get error 
messages saying you are out of memory, you may not have enough RAM available. Here are some 
tips to make the best use of your available memory:

· Close all applications that you are not using.

· Add more RAM (memory) to your computer. You can determine how much memory is available 
by starting MS-DOS, typing mem and pressing ENTER. This starts a program that will tell you 
how much memory you have. You need at least 8 MB of RAM, and 16 MB is recommended.

· If you are using more than 256 colors in your video display, you may want to lower your video 
colors to 256. For instructions on how to change your Windows display, consult your Windows 
documentation.

For more details on improving performance, consult your Windows 95 and CD-ROM manuals.

8 Hardware Problems
In rare situations, Mastering Internet Development may encounter display problems when using 
accelerated video drivers, video drivers with more than 256 colors, or high-resolution video drivers. 
One example of these problems is a video display with garbled images. Another is a crash occurring 
when trying to play a video. There are several things you can do if you encounter such problems:

1. Most problems can be fixed by obtaining new drivers from your video card manufacturer. 
Contact the manufacturer of your video card to determine if newer versions are available. The 
manufacturer's phone number should be in the manuals that came with your video card or 
personal computer. Another option for obtaining updated drivers is the Microsoft Download 
service (MSDL), an electronic bulletin board that can be accessed by modem at (206) 936-
MSDL (206-936-6735).

Drivers provided on MSDL are compressed with the PKWare utilities and are in the form of 
executable files (.EXE extension). It is best to download the file or files you need into an empty 
directory on your hard disk or a blank formatted floppy. To decompress these drivers after 
downloading them, either:

a) From Windows 95 Explorer, double-click on the filename that you downloaded.

-or-

b) From the DOS prompt, change to the directory containing the downloaded file, type 
the filename, and then press ENTER.

2. An alternative to obtaining a new or updated display driver is to change your video mode to a 



standard video mode, such as 640 x 480 resolution with 256 colors.

To find out what video driver you are using, open Display from Control Panel. In Windows 95, 
click on the Settings tab. Then click the Change Display Type button. Your display type will be 
listed there. For instructions on how to install or change drivers, click the Help button.

9 Printing Problems
Screen resolution and printer resolution are often not the same, so the resulting printout may not 
match the quality you see on the screen.

If you encounter a general protection fault when you print a topic, check your printer driver. Switch to 
a more current version of the driver, if one is available. Additionally, ensure that the printer is online 
and that you can print to it from another application. If the problem persists, click on the Property 
page for the Printer you are using. Choose the Fonts tab and click on the method of downloading 
TrueType fonts that works best with your system. 

If you are using an HP LaserJet printer, make sure that you have the most current printer driver, or try
setting the printer resolution to 300 dpi (graphics may not print properly at 600 dpi). 

You should be able to print grayscale images from Mastering Internet Development. If you have a 
black and white laser printer, you may need to upgrade your printer driver. Call the dealer from whom
you bought the printer or call the printer manufacturer.

10 Microsoft Tools Included on CD
The following categories of Microsoft tools have been included on this CD in \MEDIA\TOOLS.

· Internet Assistants
· Viewers
· Development Tools
· Internet Information Server
· ODBC Drivers

Installation instructions for installing these tools directly from the CD are in the Microsoft Tools section
of the Library. You should also check the Microsoft Web site, http://www.microsoft.com, to download 
the most recent versions of some of these tools.

11 Technical Support
For help on setup and product features:
· Check Help.
· Take the Tour, accessible through Help.
· Check the Mastering Internet Development README file on the Product Web Site.

For phone support:
· In the United States, no-charge support is available by making a toll call between 6:00am and 

6:00pm Pacific time, Monday through Friday, excluding holidays.  Call (206) 635-7033.
· In Canada, support engineers are available by making a toll call between 8:00am and 8:00pm 

Eastern time, Monday through Friday, excluding holidays.  Call (905) 568-3503.
· Outside North America, contact your local Microsoft subsidiary.

12 Generic Multimedia Information
For more information regarding Multimedia PCs (MPCs), MPC titles, and other general multimedia 
topics of interest, please contact the MPC Marketing Council:

Multimedia PC Marketing Council, Inc.
1703 M Street, Suite 700
Washington DC 20036



(202) 452-1600

For information regarding a specific MPC product, contact the manufacturer of that product.


